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This guide is intended for anyone who is setting up or starting to use a Dell® 
Inspiron™ 3500 portable computer. Both first-time and experienced computer users 
should complete Chapter 1 to properly configure a computer for operation. The 
remaining chapters describe procedures for accessing the Internet and using soft-
ware and hardware.

&$87,21� %HIRUH XVLQJ WKLV JXLGH� FRQQHFW WKH FRPSXWHU DFFRUGLQJ WR WKH
VWHSV RQ WKH *HWWLQJ 6WDUWHG VKHHW� )DLOXUH WR SURSHUO\ FRQQHFW \RXU FRP�
SXWHU PD\ UHVXOW LQ FRPSXWHU PDOIXQFWLRQV RU GDPDJH�

6DIHW\�,QVWUXFWLRQV
The Dell Inspiron 3500 Reference and Troubleshooting Guide provides detailed safety 
information.

$EEUHYLDWLRQV��$FURQ\PV��DQG�7HUPV
Abbreviations, acronyms, and computer terms are identified or defined as they are 
used in this guide. For a complete listing, refer to the Glossary in the Users Guide.

1RWDWLRQDO�&RQYHQWLRQV
NOTE: A NOTE conveys important information that helps you make better use of your 
computer.

&$87,21� $ &$87,21 LQGLFDWHV HLWKHU SRWHQWLDO GDPDJH WR KDUGZDUH RU
ORVV RI GDWD DQG WHOOV \RX KRZ WR DYRLG WKH SUREOHP�

:$51,1*� $ :$51,1* LQGLFDWHV WKH SRWHQWLDO IRU ERGLO\ KDUP DQG WHOOV
\RX KRZ WR DYRLG WKH SUREOHP�

,I�<RX�1HHG�+HOS
If you need help while using this guide, refer to Chapter 6, “Frequently Asked Ques-
tions.” For detailed troubleshooting procedures, refer to the Reference and 
Troubleshooting Guide.
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The Getting Started sheet provides 
step-by-step instructions for connecting 
your computer. Start with this 
document.

The Setup Guide explains how to 
prepare your computer for opera-
tion. It also describes how to access 
the Internet and use software and 
hardware.

,QIRUPDWLRQ�5HVRXUFHV

The Reference and Troubleshooting 
Guide provides maintenance informa-
tion, and troubleshooting procedures 
for solving common problems.

The Dell System User’s Guide contains 
information you need to use and maintain 
your portable computer. 

To open the guide, 
double-click the Dell 

System User’s 

Guide icon on your desktop.
vi
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3UHSDULQJ�<RXU�&RPSXWHU�IRU�8VH�
WKH�)LUVW�7LPH

This chapter has the information you need to prepare your computer for first-time use. 
Your computer has been shipped with the Microsoft®  Windows® 98 operating sys-
tem already installed. Perform the setup steps provided in this guide so that the 
software functions properly on your Dell computer.

6HWWLQJ�8S�:LQGRZV���
Initial setup of Windows 98 takes about 10 minutes. The setup process is customized 
according to which computer components you have.

&$87,21� %HIRUH XVLQJ WKLV JXLGH� FRQQHFW WKH FRPSXWHU DFFRUGLQJ WR WKH
VWHSV RQ WKH *HWWLQJ 6WDUWHG VKHHW� )DLOXUH WR SURSHUO\ FRQQHFW \RXU FRP�
SXWHU PD\ UHVXOW LQ FRPSXWHU PDOIXQFWLRQV RU GDPDJH�

&$87,21� 'R QRW FRQQHFW GHYLFHV VXFK DV SULQWHUV RU LQVWDOO LWHPV VXFK DV
3& &DUGV RU GULYHV EHIRUH \RX FRPSOHWH \RXU :LQGRZV �� VHWXS� 7KHVH
GHYLFHV VKRXOG RQO\ EH FRQQHFWHG RU LQVWDOOHG DIWHU WKH RSHUDWLQJ V\VWHP
VHWXS LV FRPSOHWHG� 5HPRYH DQ\ 3& &DUGV WKDW DUH LQVWDOOHG LQ \RXU SRUWD�
EOH FRPSXWHU�

&$87,21� 'R QRW DWWDFK \RXU FRPSXWHU WR D SRUW UHSOLFDWRU XQWLO WKH
:LQGRZV �� VHWXS LV FRPSOHWHG�

&$87,21� 'R QRW LQWHUUXSW WKH :LQGRZV �� VHWXS SURFHVV� 'RLQJ VR PD\
UHQGHU \RXU FRPSXWHU XQXVDEOH�

&$87,21� ,I \RX H[SHULHQFH SUREOHPV� GR QRW XVH �&WUO!�$OW!�'HO! WR
UHERRW \RXU FRPSXWHU� ,QVWHDG� WXUQ RII DQG WKHQ WXUQ RQ \RXU FRPSXWHU�
:KHQ SURPSWHG� VHOHFW 6DIH 5HFRYHU\ 0RGH WR FRQWLQXH WKH VHWXS�
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Complete the initial setup of Windows 98 on your Dell computer by following these 
steps: 

1. Turn on your computer.

NOTE: Do not press <F2> if the message Press <F2> to enter Setup  
appears. If you press <F2> now, the initial setup of Windows 98 will not com-
plete correctly. Because this message occurs each time the computer boots 
(starts), you can access the Setup program at a later time.

The Dell Software License window appears.

2. Type y  to continue. By typing y, you agree to read the software license agree-
ment that came with your computer.

NOTE: At this point in the setup process, Windows 98 has not loaded the touch 
pad driver, so you cannot use the touch pad to complete this step. Windows 98 
detects the driver that initializes the touch pad later in the setup process.

3. The Important Technical Support Information screen appears and displays 
your Express Service Code. The Express Service Code helps expedite Dell tech-
nical support. Look for the Express Service Code on the bottom of your 
computer.

NOTE: Dell’s Express Service Code may not be available in all countries.

4. Type x  to continue.

NOTE: At this point in the setup process, Windows 98 has not loaded the touch 
pad driver, so you cannot use the touch pad to complete this step. Windows 98 
detects the driver that initializes the touch pad later in the setup process.

Your computer restarts automatically.

NOTE: Do not press <F2> if the message Press <F2> to enter Setup  
appears. If you press <F2> now, the initial setup of Windows 98 will not com-
plete correctly. Because this message occurs each time the computer boots 
(starts), you can access the Setup program at a later time.

5. When the Regional Settings window appears, select the regional setting for 
your location and then click Next>.

This setting tells Windows 98 how to display numbers, dates, time, and currency.

6. In the Keyboard Layout window, accept the default (highlighted) keyboard from 
the list and then click Next>.

NOTE: If you want to change the default keyboard, click the keyboard of your 
choice.

7. In the User Information window, enter your name and, if applicable, company 
name and then click Next>. 

The Name field must be completed; the Company Name field is optional. 
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8. Read the license agreement, click I accept the Agreement, and then click 
Next>.

If you do not accept the agreement, you cannot access Windows 98. After you 
accept the license agreement, the Product Key window appears.

9. Find the Product Key on the Certificate of Authenticity on the front cover of the 
Getting Started/Microsoft Windows 98 document, enter the Product Key in the 
fields provided, and then click Next>.

10. When the Start Wizard window appears, click Finish.

The Windows Setup window appears that tracks the progress of the Windows 98 
setup. 

The Date/Time Properties window appears.

11. Click the Time Zone tab. Then select your time zone from the pull-down menu, 
and click Apply.

12. Click the Date & Time tab. Make the appropriate changes, click Apply, and then 
click OK to continue with the setup.

&$87,21� 7R SUHYHQW SRVVLEOH FRQIOLFWV ZLWK :LQGRZV ��� \RX PXVW QRW
EHJLQ SULQWHU VHWXS XQWLO WKH :LQGRZV �� VHWXS LV FRPSOHWHG�

13. Because you don’t have a printer connected, the Add Printer Wizard window 
appears. Click Cancel.

Windows continues updating your computer settings.

The Welcome to Windows 98 screen appears.

$GGLQJ�D�3ULQWHU

For instructions on connecting a printer and configuring it for Windows 98, see the 
printer manufacturer’s documentation or the Getting Started/Microsoft Windows 98 
documentation. 

8VLQJ�WKH�:HOFRPH�WR�:LQGRZV����6FUHHQ
The Welcome to Windows 98 screen enables you to learn about and configure some 
features of your operating system. It contains the following options:

� Register Now — Registers your copy of Windows 98 with Microsoft.

NOTE: To register your copy of Windows 98, you need to be connected to the 
Internet. For information about connecting to the Internet, see Chapter 2, ”Con-
necting to the Internet.” 

� Connect to the Internet — Configures your computer for Internet use. For infor-
mation about connecting to the Internet, see Chapter 2, “Connecting to the 
Internet.” 
Preparing Your Computer for Use the First Time 1-3



� Discover Windows 98 — Provides information about basic computer essentials, 
upgrading from the Windows 3.x and Windows 95 operating systems, features 
of Windows 98, and Windows 98 resources. For a tutorial of Windows 98, select 
the Windows 98 Overview option.

� Maintain Your Computer — Configures your computer for regular automated 
computer maintenance. 

NOTE: To ensure optimal performance with your Dell computer, do not change 
the defaults for this option. 

When you place the cursor over an option, the screen text to the right of Contents 
automatically updates to display information about that option. Click an option or click 
Begin to access the Register Now window. If you access an option from the 
Welcome to Windows 98 screen and then exit from it, Windows 98 returns to the 
Welcome to Windows 98 screen. To bypass the Welcome to Windows 98 screen, 
click the X in the upper-right corner of the screen. 

By default, the Welcome screen appears each time you start Windows 98, unless you 
specify otherwise by unchecking the Show this window each time Windows 98 

starts option. If you uncheck this option and want to access the Welcome to 

Windows 98 screen, click the Start button, point to Programs—>Accessories—> 
System Tools, and click Welcome to Windows.
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<RXU�FRPSXWHU�LV�UHDG\�WR�XVH�

:KDW·V�1H[W"
Chapter 2 provides information on connecting to the Internet. You must have an 
online service or Internet service provider to access the Internet.

Chapter 3 orients you to the Windows desktop. It also tells you how to change your 
wallpaper and screen saver, create shortcuts, and position icons.

Chapter 4 describes how to access, install, and remove software. It also covers basic 
file management, such as finding, copying, deleting, and renaming files.

Chapter 5 provides basic information and tips on using your computer hardware. Also 
included are general instructions for adding a printer.

Chapter 6 offers answers to commonly asked questions about your computer.

6\VWHP�8VHU·V�*XLGH
The System User’s Guide is a handy reference tool as you work on your desktop. It 
allows you to search for information in multiple ways and to quickly link to related 
topics.

To open the guide, double-click the Dell System User’s Guide icon on your desktop.
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&RQQHFWLQJ�WR�WKH�,QWHUQHW

$FFHVVLQJ�WKH�,QWHUQHW
The Windows 98 operating system enables you to configure your computer for Inter-
net use from the Online Services folder or Internet Connection wizard. Before 
accessing the Internet, use the instructions in the following subsections to complete 
the following steps. After you complete these steps, you are ready to access the 
Internet.

1. Set up your modem.

2. Set up an Internet account with an online service or an Internet service provider 
(ISP) through the Online Services folder or Internet Connection wizard.

3. Set up your Internet browser.

6HWWLQJ�8S�<RXU�0RGHP

If your computer came with an internal modem, the modem was set up along with 
other devices when the computer was shipped to you from Dell. Make sure you con-
nect the telephone line to the modem connector on the computer as illustrated in the 
Dell System User’s Guide.

If you are using a PC Card modem with your computer, Windows 98 should automati-
cally detect the new modem the next time you turn on your computer. In such case, a 
New Hardware Found window appears and prompts you for information about the 
modem, such as the model and manufacturer names, so that Windows 98 can identify 
and load the appropriate drivers. You must then restart the computer for the configu-
ration information to take effect. If Windows 98 does not detect and set up your 
modem, refer to the modem manufacturer’s documentation or contact the manufac-
turer for assistance.

6HWWLQJ�8S�DQ�,QWHUQHW�$FFRXQW

After you set up your modem, the next step to accessing the Internet is to set up an 
Internet account and configure your computer for Internet use from an online service 
or ISP. An online service provides software for connecting to a network of services, 
including the Internet. An ISP is a company that allows you to dial into its host server 
to connect directly to the Internet.
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NOTE: Dell is not an online service or ISP. Questions about your Internet account 
should be directed to your online service or ISP.

You can set up an Internet account and configure your computer for Internet use from 
the Online Services folder or Internet Connection wizard. From the Internet Con-

nection wizard, you can set up a new or existing Internet account. From the Online 

Services folder, you can set up a new Internet account only. 

6HWWLQJ 8S DQ ,QWHUQHW $FFRXQW )URP WKH 2QOLQH 6HUYLFHV )ROGHU

The Online Services folder is on the desktop. For your convenience, the following 
online services are provided in this folder:

� America Online 

� AT&T WorldNet Service

� PRODIGY® Internet

NOTES: The Microsoft Network (MSN) icon appears on your desktop. If you want to 
set up an Internet account with this online service, double-click the Set Up the 

Microsoft Network icon and follow the instructions that appear.

Dell does not provide technical support for these online services. If you have any 
questions concerning a provider's policies or offerings, contact the online service.

Perform the following steps to set up a new Internet account from this folder. 

NOTE: When you set up your Internet account through the Online Services folder, you 
do not need to reenter this information in the Internet Connection wizard. If the Inter-

net Connection wizard appears after you have set up your Internet account, click My 

computer is already set up for the Internet. Do not show me this wizard again.

1. Double-click the Online Services folder on the desktop.

For information about the providers listed, click About the Online Services in 
the Online Services folder. 

2. Determine which provider you want to use for Internet access. Double-click the 
icon for that provider.

The software prompts you for the information needed to set up a new Internet 
account, including identification and payment information.

3. Follow the instructions as they appear.

4. After your Internet account is set up, access the Internet Connection wizard by 
clicking the Start button, pointing to Programs—>Internet Explorer, and then 
clicking Connection Wizard.

5. Click My computer is already set up for the Internet. Do not show me this 

wizard again, and then click Cancel.

6. When a message asks if you want to exit the Internet Connection wizard, click 
Yes.
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Local ISPs are usually listed in your telephone directory. When choosing an ISP, com-
pare various service providers by asking the following questions: 

Is your software compatible with my operating system?

Make sure the software is compatible with Windows 98.

Do you provide a browser and e-mail program?

Most ISPs provide a popular browser like Microsoft Internet Explorer (already installed 
on your computer) or Netscape Navigator. Make sure the ISP provides setup instruc-
tions for the browser software.

How many e-mail accounts come standard with your service?

Most services provide at least one free e-mail account. You may also be able to pur-
chase additional accounts.

What is your fastest connection speed?

Make sure the ISP supports the speed of your modem.

If I have problems getting your setup program installed, how can I get help?

ISPs usually provide a telephone number you can call.

Is your setup program automated or will I have to manually set up my dial-up 

connection? 

If setup is a manual process, find out how much support the ISP provides.

Do you provide free space for my personal World Wide Web page?

Most ISPs provide free space for personal web sites.

How much idle time is allowed before being disconnected from your service?

ISPs usually set a limit of inactivity before disconnecting you from their service.

How many users per phone line does your service support?

The smaller the ratio of users to phone lines, the less chance you have of getting a 
busy signal.

How do I pay for Internet access using your service?

Some ISPs offer unlimited Internet access for a monthly fee. Others charge according 
to the amount of time you spend on the Internet.

6HWWLQJ 8S DQ ,QWHUQHW $FFRXQW )URP WKH ,QWHUQHW &RQQHFWLRQ :L]DUG

You can set up a new or existing Internet account and configure your computer for 
Internet use with the Internet Connection wizard. The Internet Connection wizard 
can be accessed from the Welcome to Windows 98 screen; or you can click the 
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Start button, point to Programs—>Internet Explorer, and then click Connection 

Wizard. The Internet Connection wizard prompts you to select one of the following 
options:

� I want to sign up and configure my computer for a new Internet account. (If 

you select this option, make sure that your telephone line is connected to 

your modem.)

Select this option to establish a new Internet account. 

When you select this option, you are prompted to enter your area code. The 
Microsoft Internet Referral System then accesses a list of ISPs in your area. Click 
an ISP to view information about that provider. Click Next> to begin setting up a 
service with the ISP. The ISP software will prompt you for information necessary 
to establish the account, including identification and payment information. 

NOTE: As part of the setup, you may be prompted to identify an outgoing mail 
server (POP3 or IMAP) and incoming mail server (SMTP). Your ISP can provide 
you with this information.

� I have an existing Internet service through my phone line or a local area net-

work (LAN). Help me set up my computer to this Internet service.

Select this option to configure your computer for Internet use with an existing 
Internet account. 

If your computer has a modem installed, your Internet service is provided via 
phone line. 

NOTE: To configure your Internet connection through a LAN, contact your net-
work administrator.

When you select this option, be prepared to provide the following information 
about your account:

� E-mail address

� User name and password

� Outgoing mail server

� Incoming mail server

� Internet news group server

� Internet directory

� My computer is already set up for the Internet. Do not show me this wizard 

again.

Select this option if you have already set up an Internet connection and config-
ured your computer for Internet use through the Online Services folder or 
Internet Connection wizard. 
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Internet Explorer 4.x is included with your Windows 98 operating system. You can 
use this browser or any other browser supported by your ISP. 

NOTE: Dell recommends that you do not install Internet Explorer 3.x if the browser 
software supplied by your ISP asks you to. Instead, finish the installation of the soft-
ware and then configure the browser for Internet Explorer 4.0.

When you contact your ISP for instructions on setting up a browser, be prepared to 
provide the following information:

� Type of computer, including the microprocessor speed

� Operating system version

� Type of modem

� Internet browser software

NOTE: To use your browser, you must be connected to the Internet through your 
online service or ISP; otherwise, an error message appears.
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&XVWRPL]LQJ�WKH�:LQGRZV�'HVNWRS

This chapter describes the main features of the Windows desktop and explains how 
to customize the Windows 98 operating system for your use. It also tells you how to 
get help while using Windows.

If you are a new Windows user, the Windows tutorial can help orient you to Windows 
operations. To access the tutorial, click the Start button and then click Help. On the 
Contents tab, double-click Introducing Windows 98.

0DMRU�)HDWXUHV�RI�WKH�:LQGRZV�'HVNWRS�
Although your computer may vary slightly depending on its hardware and software 
configuration, the Windows desktop has many standard features (see Figure 3-1). 
Table 3-1 describes these features.

 

)LJXUH ���� :LQGRZV 'HVNWRS

taskbar

program 
buttons

My 
Computer 
icon

Recycle 
Bin icon

Internet 
Explorer 
icon

Start 
button
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)LJXUH ���� 6WDUW %XWWRQ 0HQX

7DEOH ���� 0DMRU )HDWXUHV RI WKH :LQGRZV 'HVNWRS

)HDWXUH )XQFWLRQ

Taskbar The area at the bottom of the screen is called the taskbar. 
When you open a program, a button appears on the taskbar. 
The taskbar contains the Start button on the left and a clock on 
the right. You may also see other icons on the taskbar, depend-
ing on your computer’s software and hardware features.

Start button The Start button provides access to the contents of your 
computer. Click the Start button to display a menu containing 
the computer’s main program and program group icons (see 
Figure 3-2). Refer to Table 3-2 for descriptions of the Start 
menu options.

My Computer Double-click this icon to display the contents of your computer. 
Icons appear for any installed drives, as well as the Control 
Panel, printers, and so on. Refer to “My Computer” in 
Chapter 4 for more information.

Recycle Bin When you delete a file from your computer, it moves to the 
Recycle Bin, where it can later be retrieved. To permanently 
remove files, empty the Recycle Bin as explained in “Deleting 
Files” in Chapter 4.

Internet 
Explorer

Double-click this icon to launch the Internet Connection Wiz-
ard and prepare to access the Internet.

Start 
button

taskbar
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For more information on the Windows desktop, refer to the Microsoft documentation 
that accompanied your computer.

:RUNLQJ�:LWKLQ�3URJUDP�:LQGRZV
Each program and document has a title bar at the top of the window that displays the title 
of the window. The title bar includes three small icons on the right side (see Figure 3-3).

)LJXUH ���� :LQGRZV 7LWOH %DU

7DEOH ���� 6WDUW 0HQX 2SWLRQV

6WDUW 0HQX 2SWLRQ )XQFWLRQ

Programs Displays a list of installed programs you can start.

Favorites Displays a list of favorite Web content and sites, including 
the Dell Channel.

Documents Displays a list of most-recently opened documents.

Settings Displays a list of user-configurable computer components.

Find Displays a menu to help you find files, folders, or computers 
to which you are connected.

Help Opens the help system that provides instructions for using 
Windows. Refer to “Using Windows Help” found later in 
this chapter for more information.

Run... Displays a window for starting a program or file with an 
MS-DOS® command.

Log Off... Logs off current user so that a new user can log on.

Shut Down... Displays a window with options for shutting down, 
restarting, or logging off of your computer.

minimize button
close button

maximize button

resize button
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Click the minimize button to close the window but leave the program running (click 
the program’s button on the taskbar to restore the window). Click the maximize but-
ton to size the window to the screen, and click the resize button to return the window 
to its original size. Click the close button to close the document or program.

Each time you open a program, a button for that program appears on the taskbar (see 
Figure 3-4). You can click the buttons to toggle between open programs.

)LJXUH ���� 7DVNEDU DQG 3URJUDP %XWWRQV

&RQWURO�3DQHO�
The Control Panel contains many of the tools used to change how Windows looks 
and works. To access the Control Panel, follow these steps:

1. Click the Start button, point to Settings, and then click Control Panel (see Fig-
ure 3-5).

A window containing system setup icons appears.

)LJXUH ���� &RQWURO 3DQHO :LQGRZ

Typical icons include Display, Keyboard, Mouse, and Printers.

NOTE: The icons in the Control Panel vary depending on the hardware and soft-
ware configuration of your computer. Point your mouse cursor at an icon to pop 
up a short description of its settings.

2. Double-click an icon to see the settings that you can change for that item.

program 
buttons taskbar
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6HWWLQJ�8S�'LVSOD\�3URSHUWLHV
The Display Properties window contains controls for customizing the way Windows 
looks on your computer. For example, you can change your desktop’s wallpaper (back-
ground) and screen saver. To access display settings, follow these steps: 

1. Click the Start button, point to Settings, and then click Control Panel.

2. Double-click the Display icon.

The Display Properties window opens with the Background tab selected by 
default (see Figure 3-6).

)LJXUH ���� %DFNJURXQG 7DE RI WKH 'LVSOD\ 3URSHUWLHV :LQGRZ

&KDQJLQJ�WKH�:DOOSDSHU�

Use the Background tab of the Display Properties window to change the wallpaper 
(background appearance of the Windows desktop). Table 3-3 describes the options 
available under the Background tab. After you make any changes, click Apply or OK.

NOTE: You can click Apply at any time while working in Windows 98 to continue mak-
ing selections; click OK if you do not want to continue making selections. 

preview 
window

Background tab

Wallpaper list

Pattern 
button

Display 
pull-down 
menu 
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&KDQJLQJ�WKH�6FUHHQ�6DYHU�

Screen savers are programs that prevent a static image from damaging the monitor. 
They start automatically after a user-defined period of inactivity. To change your 
computer’s screen saver, click the Screen Saver tab in the Display Properties 
window (see Figure 3-7).

)LJXUH ���� 6FUHHQ 6DYHU 7DE RI WKH 'LVSOD\ 3URSHUWLHV :LQGRZ

Table 3-4 describes the various parts of the Screen Saver tab. After you make any 
changes, click Apply or OK to apply them.

T

7DEOH ���� %DFNJURXQG 7DE )HDWXUHV

)HDWXUH )XQFWLRQ

Preview window Displays the current wallpaper or pattern.

Wallpaper list Click the name of the wallpaper you want to display, or click 
(None) if you prefer not to use a wallpaper image. Click the 
Browse button to use images in a directory you specify.

Pattern button Click the Pattern button to display a list of patterns for your 
desktop, or click (None) if you prefer not to use a pattern.

Display pull-down 
menu

Click Tile to tile a wallpaper image across the entire screen, 
or click Center to place a single copy of the image in the 
center of the screen. This option is available only if you have 
selected a wallpaper.

Screen Saver 
pull-down menu

preview 
window

Screen 
Saver tab

Settings 
button

Preview 
button
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NOTE: Depending on your monitor, you may also have fields for other display controls, 
such as energy-saving features. For more information, refer to the documentation that 
came with your monitor.

6KRUWFXWV��
Shortcuts are icons that provide quick access to frequently used programs, files, fold-
ers, and drives. By double-clicking a shortcut, you can open its corresponding folder or 
file without having to find it first. Shortcuts do not change the location of files; if you 
delete a shortcut, the original file is not affected.

&UHDWLQJ�D�6KRUWFXW�RQ�WKH�'HVNWRS

To create a shortcut, follow these steps:

1. Open the My Computer window or Windows Explorer.

To open the My Computer window, double-click the My Computer icon on the 
desktop. 

To open Windows Explorer, right-click the My Computer icon on the desktop 
and then click Explore.

2. Find the item for which you want a shortcut.

3. Using your right mouse button, click the object and drag it to the desktop.

4. Release the right mouse button.

A menu appears next to your cursor.

5. Click Create Shortcut(s) Here.

An icon appears on your desktop that you can double-click at any time to activate 
the shortcut.

7DEOH ���� 6FUHHQ 6DYHU 7DE )HDWXUHV

)HDWXUH )XQFWLRQ

Preview window Displays the current screen saver.

Screen Saver 
pull-down menu

Choose a screen saver from the pull-down menu, or click 
(None) if you prefer not to activate a screen saver.

Settings button Click this button to change various features of the screen 
saver.

Preview button Click this button to run the currently selected screen saver.
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$UUDQJLQJ�DQG�3RVLWLRQLQJ�6KRUWFXWV�

The shortcuts you create on your desktop can be easily moved and arranged. To indi-
vidually move shortcuts, point your mouse cursor at the icon, click it, and drag it to the 
desired location.

To arrange all of your shortcut icons at once, follow these steps:

1. Move your mouse cursor to an empty spot on the desktop, and click the right 
mouse button.

2. From the pop-up menu, point to Arrange Icons.

3. Click the option for the icon arrangement you prefer.

The icons are automatically arranged.

8VLQJ�:LQGRZV�+HOS��
An extensive help system is built into your Microsoft operating system. To access 
Help, click the Start button and then click Help.

The Windows Help window appears (see Figure 3-8).

)LJXUH ���� &RQWHQWV 7DE RI :LQGRZV +HOS

The Contents tab lists help topics by subject, the Index tab lists topics alphabetically, 
and the Search tab lets you search for topics based on words you provide.

For more information on using Windows Help, refer to Microsoft Windows documen-
tation that came with your computer.
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8VLQJ�DQG�,QVWDOOLQJ�6RIWZDUH

This chapter provides information about using the Windows 98 operating system to 
perform basic tasks, such as starting programs, managing files, and properly shutting 
down your computer. It also discusses adding and removing software packages and 
loading device drivers.

$FFHVVLQJ�3URJUDPV�
To access your programs, follow these steps:

1. Click the Start button, and then point to Programs. 

In the Programs menu, a folder icon appears next to program groups with 
multiple programs.

2. Click the program you want to start.

%DVLF�)LOH�0DQDJHPHQW
Windows 98 provides file management and browsing capabilities with Windows 

Explorer and My Computer.

0\�&RPSXWHU�

My Computer contains various icons that represent the contents of your computer. 
Icons appear for any installed drives, as well as the Control Panel and printers. To 
open the My Computer window (see Figure 4-1), double-click the My Computer icon 
on the desktop.
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)LJXUH ���� 0\ &RPSXWHU :LQGRZ

To view the contents of any drive or folder, double-click its icon. As shown in 
Figure 4-1, your hard-disk drive may be partitioned into multiple logical drives. Each 
logical drive appears as a separate drive letter (C:, D:, E:, and so on).

For more information on My Computer, refer to the Microsoft documentation that 
came with your computer.

:LQGRZV�([SORUHU�

Windows Explorer displays the contents of your computer as a hierarchical list, or 
tree (see Figure 4-2). You can use this program to locate files on any drive or folder in 
your computer.

To open Windows Explorer, click the Start button, point to Programs, and then click 
Windows Explorer. Alternatively, right-click My Computer, and then click Explore.
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)LJXUH ���� :LQGRZV ([SORUHU

The left side of the window shows drives and folders, and the right side lists the files 
in the drive or folder selected. A plus (+) icon to the left of a drive or folder indicates 
the presence of additional folders. Click the plus icon to expand the view one level. To 
collapse the view, click the minus (–) icon to the left of a drive or folder. 

)LQGLQJ�)LOHV�

To locate a particular file or folder, follow these steps:

1. Click the Start button, point to Find, and then click Files or Folders.

The Find: All Files window opens with the Name & Location tab selected and 
the cursor in the Named: field (see Figure 4-3).

)LJXUH ���� )LQG� $OO )LOHV :LQGRZ

plus 
icon

drive 
icons

folder 
icon
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2. Type the name of the file or folder you want to find.

3. Specify where you want Windows to search by clicking the arrow next to the 
Look in: field.

NOTE: If you do not change the default setting (Document Folders), Windows 
searches the entire hard-disk drive (or drive C partition).

4. Click the Find Now button to begin the search.

Windows lists any files meeting your search criteria below the Find: All Files 

window.

&RS\LQJ�)LOHV�

To place a copy of a file in a new location, follow these steps:

1. Use Windows Explorer or My Computer to locate the file you want to copy.

2. Click the file to select it.

3. Click the Edit menu, and then click Copy.

4. Open the folder where you want to copy the file.

5. Click the Edit menu, and then click Paste.

0RYLQJ�)LOHV�

&$87,21� 'R QRW PRYH ILOHV WKDW DUH SDUW RI DQ LQVWDOOHG SURJUDP� 'RLQJ
VR PD\ UHQGHU WKH SURJUDP XQXVDEOH�

To move a file to a new location, follow these steps:

1. Use Windows Explorer or My Computer to locate the file you want to move.

2. Click the file to select it.

3. Click the Edit menu, and then click Cut.

4. Open the folder where you want to move the file.

5. Click the Edit menu, and then click Paste.

5HQDPLQJ�)LOHV�

To change the name of a file, follow these steps:

1. Use Windows Explorer or My Computer to locate the file you want to rename.

2. Click the file to select it.
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3. Click the File menu, and then click Rename.

4. Type the new filename and press <Enter>.

&$87,21� 'R QRW FKDQJH WKH ILOHQDPH H[WHQVLRQ �ODVW WKUHH FKDUDFWHUV
DIWHU WKH SHULRG�� 'RLQJ VR PD\ UHQGHU WKH ILOH XQXVDEOH� 'R QRW
UHQDPH ILOHV WKDW DUH SDUW RI DQ LQVWDOOHG SURJUDP� 'RLQJ VR PD\ UHQ�
GHU WKH SURJUDP XQXVDEOH�

'HOHWLQJ�)LOHV�

&$87,21� 'R QRW GHOHWH ILOHV WKDW DUH SDUW RI DQ LQVWDOOHG SURJUDP� 'RLQJ
VR PD\ UHQGHU WKH SURJUDP XQXVDEOH�

To delete a file, follow these steps:

1. Use Windows Explorer or My Computer to locate the file you want to delete.

2. Click the file to select it.

3. Click the File menu, and then click Delete.

5HWULHYLQJ D 'HOHWHG )LOH )URP WKH 5HF\FOH %LQ

When you delete a file, it moves to the Recycle Bin. It is not removed from the 
computer until you empty the Recycle Bin.

&$87,21� )LOHV GHOHWHG IURP D GLVNHWWH RU IURP D QHWZRUN GULYH DUH HUDVHG
SHUPDQHQWO\� 7KH\ DUH QRW VHQW WR WKH 5HF\FOH %LQ�

If you delete a file in error and need to retrieve it from the Recycle Bin, follow these 
steps:

1. Double-click the Recycle Bin icon located on the desktop.

The Recycle Bin window opens and lists all deleted files, their previous locations, 
and the date you deleted them.

2. Click the file you want to restore.

3. Click the File menu, and then click Restore.

The file disappears from the Recycle Bin and is restored to its original location.

(PSW\LQJ WKH 5HF\FOH %LQ

Deleted files sent to the Recycle Bin still use space on the computer’s hard-disk 
drive. To free up disk space, periodically empty the Recycle Bin by following these 
steps:

1. Double-click the Recycle Bin icon located on the desktop.

The Recycle Bin window opens and lists all deleted files, their previous locations, 
and the date you deleted them.
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2. Click the File menu, and then click Empty Recycle Bin.

3. When a confirmation dialog box appears, click Yes to delete the file(s).

All files disappear from the Recycle Bin and are removed from the computer.

6KXWWLQJ�'RZQ�<RXU�&RPSXWHU�
&$87,21� 7R SUHYHQW GDWD ORVV� LW LV LPSRUWDQW WKDW \RX SHUIRUP WKH IROORZ�
LQJ VKXWGRZQ SURFHGXUH EHIRUH \RX WXUQ RII \RXU FRPSXWHU�

To shut down your computer, follow these steps:

1. Exit any applications in which you are working.

2. Click the Start button, and then click Shut Down.

The Shut Down Windows dialog box appears with the Shut down radio button 
selected (see Figure 4-4).

)LJXUH ���� 6KXW 'RZQ :LQGRZ

3. Click OK to shut down your computer.

A message states that your computer is shutting down. The computer auto-
matically turns off after the shutdown process finishes.

4. Turn off your monitor and any other devices connected to power.

:LQGRZV����8SGDWH�:L]DUG
To ensure optimal performance with Windows 98, your computer has been config-
ured and tested by Dell. Should you want to update your computer, Dell recommends 
that you download updates from Dell’s World Wide Web site at www.dell.com. 
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&$87,21� 'HOO UHFRPPHQGV WKDW \RX GR QRW XVH WKH :LQGRZV �� 8SGDWH
:L]DUG WR XSGDWH \RXU FRPSXWHU EHFDXVH GULYHUV� XSGDWHV� DQG V\VWHP
WRROV DYDLODEOH IURP WKH 8SGDWH :L]DUG PD\ QRW EH WHVWHG E\ 'HOO RU EH
FRPSDWLEOH ZLWK \RXU FRPSXWHU� <RXU FRPSXWHU PD\ EHFRPH XQXVDEOH LI \RX
XSGDWH LW XVLQJ WKH 8SGDWH :L]DUG�

NOTE: Dell provides support for your computer as it was configured by Dell. Dell does 
not provide support for computers that are updated using the Windows 98 Update 

Wizard. 

,QVWDOOLQJ�DQG�&RQILJXULQJ�$GGLWLRQDO�
6RIWZDUH��
If you are unsure whether Dell installed a particular software package you ordered, 
you can quickly check by clicking the Start button, pointing to Programs, and scan-
ning the programs listed in the Programs menu. If the program is listed, it has already 
been installed and you do not need to reinstall it from the diskettes or CDs you 
received with your computer. Store the diskettes and CDs in a safe place.

Before installing any new software, check the program’s specifications to ensure that 
it was designed to run on your computer’s installed hardware and software. For 
example, many software packages list the microprocessor, minimum memory config-
uration, and hard-disk drive space required for proper operation. They also list the 
operating system versions that are compatible with the software.

To install or configure new software on your computer, follow the manufacturer’s 
instructions. If it fails to install or run properly, contact the software manufacturer for 
technical support.

NOTE: DellWare® products are supported by the item's manufacturer. To receive 
product support information, call 1-800-753-7201.

5HPRYLQJ�6RIWZDUH��
To remove a program from your computer, follow these steps.

&$87,21� 'R QRW LQWHUUXSW RU VWRS WKLV SURFHVV RQFH EHJXQ� RWKHUZLVH� GDWD
ORVV DQG FRUUXSWLRQ RI \RXU RSHUDWLQJ V\VWHP FRXOG UHVXOW�

1. Click the Start button, point to Settings, and then click Control Panel.

2. In the Control Panel, double-click Add/Remove Programs.

3. Select the program you want to delete from the programs listed, and click 
Add/Remove . . . .

4. Follow the instructions and prompts to delete all installed components.

5. When finished, click OK.
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'HYLFH�'ULYHUV��
Drivers are software files that enable your computer to communicate with installed 
and connected devices. 

All of the devices installed by Dell already have drivers installed. If you add devices, 
such as a printer, they may require additional drivers to work properly. Contact the 
device manufacturer if the necessary drivers are not provided on a diskette or CD.

Windows 98 may detect new hardware automatically when you restart the computer. 
If Windows 98 detects new hardware, a New Hardware Found window appears, 
and you are prompted for information about the device so that Windows 98 can iden-
tify and load the appropriate drivers. You must then restart the computer for the 
configuration information to take effect.

%DFNLQJ�8S�)LOHV��
It is important to make backups (copies) of all your data files. Data files are the files 
(documents, graphics, records, and so on) you create with your programs.

NOTE: No backups need be made for software packages or for your operating system. 
The Microsoft Windows 98 CD has a copy of the operating system, and the Dell 
Inspiron 3500 Software CD has copies of the system device drivers. Additionally, any 
software you purchase comes with diskettes or CDs.

For more information on backing up files, refer to the ”Maintaining the System“ sec-
tion of the System User’s Guide.

&UHDWLQJ�D�:LQGRZV����6WDUW�8S�'LVNHWWH
It is essential that you create a Windows 98 start-up diskette. You will need this dis-
kette if you ever have to reinstall Windows 98. Once you have created the diskette, 
store it in a safe place.

Follow these steps to make the Windows 98 start-up diskette:

1. Label a blank diskette Windows 98 Start-up Diskette.

2. Click the Start button, point to Settings, and click Control Panel.

3. Double-click the Add/Remove Programs icon.

4. Click the Startup Disk tab and then click Create Disk.

5. Insert the blank diskette into the diskette drive and click OK.

6. When prompted, remove the diskette from the diskette drive.
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8VLQJ�:LQGRZV����3RZHU�0DQDJHPHQW�
)HDWXUHV
When you run Windows 98, the power management features of your Dell portable 
computer can be set through the Power Management Properties window.  

To access the Power Management Properties window and set the power manage-
ment features through Windows 98, perform the following steps:

1. Click the Start button, point to Settings, and click Control Panel.

2. Double-click the Power Management icon.

3. Set the power management features.

The Power Management Properties window contains the following tabs:

� Power Schemes — Allows you to select the power scheme (Always On, Home/

Office Desktop, and Portable/Laptop) and power mode setting for your 
computer.

� Alarms — Allows you to set the Low battery and Critical battery alarm to alert 
you that the computer battery has gone below a certain percentage. When you 
received your Dell portable computer, the Low battery and Critical battery 
alarms check boxes were checked. Dell recommends that these options remain 
checked.

� Power Meter — Allows you to view the percentage of battery life remaining 
when your computer is operating on battery power. If your computer is operating 
on AC power, a message is displayed.

� Advanced — Allows you to display the Power Meter on the Windows 98 taskbar 
and to display a password prompt when the computer resumes from standby 
mode.

2EWDLQLQJ�7HFKQLFDO�$VVLVWDQFH
Dell has established a dedicated toll-free telephone number to assist Inspiron 3500 
computer customers in the U.S. and Canada. Dell’s technical support staff can answer 
your questions about features and operation of the Inspiron 3500 computer. This help 
is available 24 hours a day, seven days a week. To contact Inspiron 3500 technical sup-
port, call 1-877-326-3355. Before you call, locate your Express Service Code on the 
bottom of the computer.

To contact the appropriate technical support for your area, see the section titled “Con-
tacting Dell” in the Dell System User’s Guide or the chapter titled “Getting Help” in 
the Reference and Troubleshooting Guide. Before you call, locate your Express Ser-
vice Code on the bottom of your computer.
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8VLQJ�&RPSXWHU�+DUGZDUH

This chapter provides information and tips on using your computer hardware (physical 
parts of a computer). It also includes general instructions for using a port replicator.

Many of the computer devices you might want to use or connect come with their 
own instructions and/or software. You should follow the device manufacturer’s 
instructions when connecting and using these devices.

:$51,1*� )RU \RXU SHUVRQDO VDIHW\ DQG SURWHFWLRQ RI \RXU FRPSXWHU�
DOZD\V WXUQ RII \RXU FRPSXWHU DQG GLVFRQQHFW LW IURP $& SRZHU EHIRUH
DWWDFKLQJ DQ\ GHYLFHV�

9LGHR�'LVSOD\�
The video display system consists of the video card installed in the computer and the 
display connected to it. They work together to produce the picture you see on your 
screen. To display a program at a specific resolution (maximum number of pixels that 
can be displayed), both the video card and display must support the resolution and the 
necessary video drivers must be installed.

&KDQJLQJ�WKH�'LVSOD\�5HVROXWLRQ���

To adjust the video resolution and the number of colors on your display, follow these 
steps:

1. Click the Start button, point to Settings, and then click Control Panel.

2. Double-click the Display icon.

The Display Properties window appears. 
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3. Click the Settings tab (see Figure 5-1).

)LJXUH ���� 'LVSOD\ 3URSHUWLHV :LQGRZ

4. Point the cursor at the slidebar in the Screen area. Then click and hold down the 
left button.

5. Move the slidebar to the left to decrease the resolution or to the right to increase 
the resolution.

NOTE: As the resolution increases, icons and text appear smaller on the screen.

6. Click Apply.

A dialog box informs you that the process may take 15 seconds and that the 
screen may flicker while the resolution is changed.

7. Click OK and then Yes to accept the new setting.

8. In the Colors box, choose the number of colors from the menu provided.

If you need further information on using the Display Properties window, see your 
Microsoft Windows 98 operating system documentation.

NOTES: Your computer's active-matrix extended graphics array (XGA) display supports 
a video resolution of 1024 x 768 and 16 million colors.

The video drivers Dell installed for you are designed to offer the best performance on 
the computer. It is recommended that you use only these drivers with your factory-
installed operating system.
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If you select a resolution higher than that supported by the built-in display, panning 
allows you to view the image in sections on the display. A high-resolution mode can 
also be used on an external multifrequency monitor connected to the computer. If you 
are not sure which resolutions your monitor can display, check the documentation that 
came with the monitor.

$GMXVWLQJ�%ULJKWQHVV

To accommodate local lighting conditions or video output from the software you are 
using, you can use key combinations to adjust the brightness of your display:

� Press <Fn><down-arrow> to decrease brightness

� Press <Fn><up-arrow> to increase brightness

NOTE: When running the computer on battery power, set the computer's brightness 
control to the lowest setting that affords comfortable viewing. You can conserve up to 
5 percent of battery power by using the minimum brightness setting.

([WHUQDO�0RQLWRU
Your Dell Inspiron computer has a monitor connector for attaching an external monitor. 
To connect and use an external monitor, follow these steps.

&RQQHFWLQJ�DQ�([WHUQDO�0RQLWRU

1. Turn off the external monitor and your computer. 

2. Set the monitor on a monitor stand, desk top, or other level surface near the 
computer.

&$87,21� 'R QRW SODFH WKH PRQLWRU GLUHFWO\ RQ WRS RI \RXU SRUWDEOH
FRPSXWHU� HYHQ LI LW LV FORVHG� 'RLQJ VR FDQ FUDFN WKH FRPSXWHU FDVH� WKH
GLVSOD\� RU ERWK�
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3. Plug the monitor cable connector into the matching monitor connector at the 
back of the computer. If the cable is not permanently attached to the monitor, 
connect it to the monitor also (see Figure 5-2).

)LJXUH ���� &RQQHFWLQJ DQ ([WHUQDO 0RQLWRU

4. Tighten all the screws on the monitor cable connector(s) to eliminate radio fre-
quency interference (RFI).

5. Connect your external monitor to a grounded electrical outlet. Plug the three-
prong connector on one end of the monitor's power cable into a grounded power 
strip or some other grounded power source. If the cable is not permanently 
attached to the monitor, connect it to the monitor also.

8VLQJ�DQ�([WHUQDO�0RQLWRU

The video image can be displayed on an external monitor, on the computer's display, 
or on both simultaneously. To toggle between the three display modes, press 
<Fn><F8>.

If the external monitor is turned off when you boot the computer, and if the Video 

Display Device option is set to CRT Mode in the Main menu of the Setup program, 
the computer sends the video image to the external monitor. In this case, you do not 
see an image on either the computer's display or on the external monitor. To resolve 
this situation, turn on the external monitor or press <Fn><F8> to switch the video 
image to the computer's display.

Whether you are using an appropriately equipped multifrequency monitor only or are 
using an external monitor and the built-in display simultaneously, you can display up to 
64,000 colors at a noninterlaced resolution of 1024 x 768 pixels.

NOTE: When the external monitor and built-in display are used simultaneously, the 
refresh rate of the built-in display is always 60 hertz (Hz).
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&KDQJLQJ�WKH�5HIUHVK�5DWH�RQ�([WHUQDO�0RQLWRUV

The refresh rate is the rate at which the monitor redraws the video image on the 
screen. The higher the refresh rate, the less video flicker can be seen by the human 
eye. If the video image on an external monitor appears to flicker (typically at a refresh 
rate of 60 Hz), select a higher supported refresh rate by following these steps:

1. Click the Start button, point to Settings, and then click Control Panel. 

The Control Panel window appears.

2. Double-click the Display icon and then click the Settings tab. 

The Display Properties window appears. 

3. Click Advanced.

The NeoMagic Magic Media 256AV Properties window appears.

4. Click the NeoMagic tab.

5. In the Internal Display section on the left side of the window, deselect LCD. 

6. In the External Display section on the right side of the window, set the refresh 
rate with the Refresh Rate slider bar (see Figure 5-3).

)LJXUH ���� &KDQJLQJ WKH 5HIUHVK 5DWH

7. Select a refresh rate, and click Apply, then click OK and then Yes to accept the 
new setting.
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%DWWHULHV
The computer uses lithium ion batteries for power when it is not connected to an AC 
power source. The main battery comes standard in the battery bay of the computer. 
You can also use a second battery in the options bay.

)LJXUH ���� ,QVWDOOLQJ D %DWWHU\ LQ WKH %DWWHU\ %D\

,QVWDOOLQJ�D�%DWWHU\�LQ�WKH�%DWWHU\�%D\

Follow these steps to remove a battery from the battery bay and install another 
battery:

1. Save any files you have open.

2. If your computer is operating on battery power, preserve your data in one of the 
following ways:

� Connect the AC Adapter and plug it into an electrical outlet. 

� From the Start menu, shut down your computer.

3. Using your index finger, pull the battery bay latch (located on the side of the com-
puter next to the battery bay) toward you (see 1 in Figure 5-4). With your thumb, 
gently push the latch out and back (see 2 in Figure 5-4) until the battery pops out 
(see 3 in Figure 5-4).

4. Grasp the battery firmly and slide it out of the battery bay.

5. Close the battery bay latch by using your index finger to push it toward the front 
of the computer until it is flush with the computer casing. Using your thumb, 
push the battery bay latch in. 

battery

battery bay latch
(unlocked position)

battery latch
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6. Close the battery bay latch by pushing it back into the computer until it is flush 
with the computer casing. 

7. Start the computer.

For instructions on installing a battery in the options bay, see “Options Bay” found 
later in this chapter. See the Dell System User’s Guide for more information on using 
the battery.

.H\ERDUG��
You can connect an external keyboard or keypad with a standard connector to the 
PS/2 connector on the computer by using an adapter available from Dell (see 
Figure 5-5).

)LJXUH ���� $WWDFKLQJ DQ ([WHUQDO .H\ERDUG�.H\SDG

Turn off the computer before connecting or disconnecting a keyboard.

NOTE: You can use the built-in keyboard when an external keyboard is attached to the 
computer.

(PEHGGHG�1XPHULF�.H\SDG�

As you work, you may want to use the embedded numeric keypad to enter numbers 
in spreadsheets or financial programs (see Figure 5-6).

)LJXUH ���� (PEHGGHG 1XPHULF .H\SDG
Using Computer Hardware 5-7



The embedded numeric keypad shares some of the keys on your computer's key-
board. The keypad numbers and symbols are marked on the right of the keypad keys.

NOTE: Key combinations can be used when the keypad is off or on.

To activate the embedded numeric keypad, follow these steps:

1. Press <Num Lock>.

The Pad Lock indicator illuminates.

2. Press and hold <Fn> to toggle between the letter and number keys.

To deactivate the keypad, press <Num Lock> again. The Pad Lock indicator is no 
longer illuminated.

NOTE: The embedded numeric keypad is automatically disabled if an external key-
board or keypad is connected to the computer.

To adjust keyboard operation, such as the character repeat rate, double-click the 
Keyboard icon in the Control Panel (refer to “Control Panel” in Chapter 3).

.H\�&RPELQDWLRQV

Table 5-1 lists various key combinations that you can use to complete certain func-
tions. For more information on key combinations, refer to the Dell System User’s 
Guide.

7DEOH ���� .H\ &RPELQDWLRQV DQG )XQFWLRQV

.H\ &RPELQDWLRQ )XQFWLRQ

Windows Logo Key Combinations 

<Logo key><m> Minimizes all open windows

<Logo key><Shift><m> Maximizes all windows

<Logo key><e> Opens Windows Explorer

<Logo key><r> Opens the Run dialog box

<Logo key><f> Opens the Find Files dialog box

<Logo key><Ctrl><f> Opens the Find Computer dialog box 
(if you are connected to a network)

<Logo key><Pause> Opens the System Properties dialog 
box
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7RXFK�3DG
The PS/2-compatible touch pad (see Figure 5-7) detects the position of your finger 
over a touch-sensitive area and provides the computer full mouse functionality. The 
touch pad's two buttons correspond to the left and right buttons on a standard 
mouse.

Display Key Combinations 

<Fn><F8> Toggles the video image to the next dis-
play in the following sequence:

� Built-in display

� External monitor

� Both displays simultaneously

<Fn><down-arrow> Incrementally decreases brightness

<Fn><up-arrow> Incrementally increases brightness

Power Conservation Key 
Combinations 

<Fn><Esc> Activates standby mode

<Fn><a>
(or <Fn><q> on a French keyboard)

Activates save-to-disk suspend mode

Speaker Key Combinations 

<Fn><Page Up> Increases the volume of the built-in 
speakers and the external speakers, if 
attached

<Fn><Page Down> Decreases the volume of the built-in 
speakers and the external speakers, if 
attached

<Fn><End> Enables and disables the built-in speak-
ers and the external speakers, if 
attached 

System Functions Key Combinations 

<Ctrl><Alt><Delete> Restarts (reboots) the computer

<Fn><Num Lock> Enables and disables the embedded 
numeric keypad

7DEOH ���� .H\ &RPELQDWLRQV DQG )XQFWLRQV �FRQWLQXHG�

.H\ &RPELQDWLRQ )XQFWLRQ
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)LJXUH ���� 7RXFK 3DG DQG %XWWRQV

To move the cursor, lightly slide your finger over the smooth sensor area. To select an 
object, gently tap once on the surface of the touch pad. To select and move (or drag) 
an object, position the cursor on the object and tap down-up-down on the touch pad. 
On the second down motion, leave your finger on the touch pad and move the 
selected object by sliding your finger across the surface. To double-click an object, 
position the cursor on the object and then tap twice.

To customize touch pad and cursor features, follow these steps:

1. Click the Start button, point to Settings, and then click Control Panel. 

The Control Panel window appears.

2. Double-click the Mouse icon.

3. Select the Touch Pad tab.

4. Make your desired selections. Click Help if you need more information.

5. To incorporate your changes, click Apply. 

To use the touch pad, the PS/2 Mouse option in the System Devices menu of the 
Setup program must be Enabled. Dell has already installed the touch pad drivers for 
you.

NOTE: Keep your fingers away from the touch pad while the computer is booting or 
loading the operating system. If you touch the touch pad at either time, the cursor will 
not move until you remove your finger from the touch pad surface.

touch-pad buttons touch pad
5-10 Dell Inspiron 3500 Setup Guide



0RXVH�
You may attach a PS/2-compatible mouse to the PS/2 connector on the computer or a 
Universal Serial Bus (USB)-compatible mouse to the USB connector.

NOTE: Before connecting or disconnecting a PS/2 mouse, turn off your computer. If 
you attach a USB mouse to the computer, you do not need to reboot in order to use 
the mouse.

While the mouse is attached to the computer, the touch pad is disabled. The touch 
pad device drivers that Dell installed on your hard-disk drive work with a PS/2 mouse, 
serial mouse, or USB mouse from Dell. If you did not receive your mouse from Dell, 
you must install device drivers separately to use the mouse. This software is usually 
included with mouse installation kits.

If you attach a serial mouse to the serial connector, set the PS/2 Mouse option in the 
System Devices menu to Disabled.

To adjust mouse operation, such as the pointer speed and right/left-handed button 
configuration, double-click the Mouse icon in the Control Panel (refer to “Control 
Panel” in Chapter 3). For more information, refer to the documentation that came 
with your mouse.

2SWLRQV�%D\�
When you receive your computer, a diskette drive is installed in the options bay. The 
options bay supports a secondary battery, a CD-ROM drive, a diskette drive, a 
DVD-ROM drive, or a zip drive. 

Follow these steps to remove a device from the options bay and install another 
device:

1. Save any files you have open.

2. Shut down the computer.

3. Using your index finger, pull the options bay latch (located on the side of the com-
puter next to the options bay) toward you (see 1 in Figure 5-8). With your thumb, 
gently push the options bay latch out (see 2 in Figure 5-8) and back until the 
device pops out (see 3 in Figure 5-8).

4. Grasp the device firmly and slide it out of the options bay.
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)LJXUH ���� 5HPRYLQJ D 'HYLFH )URP WKH 2SWLRQV %D\

5. With the options bay latch released, slide the new device into the options bay 
until it is flush with the computer casing.

6. Close the options bay latch by using your index finger to push it toward the front 
of the computer until it is flush with the computer casing. Using your thumb, 
push the options bay latch in.

7. Turn on the computer.

NOTE: Before you remove a module from the options bay, turn off the computer. 
After you install a module in the options bay, reboot the computer so that the 
operating system recognizes the module.

8VLQJ�3OXJ�DQG�3OD\�'HYLFHV
Plug and Play is an industry-standard specification that enables you to add certain devices 
to your computer, which, after you restart your computer, are automatically detected and 
configured for use with your computer. A Plug and Play device requires an operating sys-
tem that has Plug and Play technology implemented, such as Windows 98. Examples of 
Plug and Play devices are a mouse, joystick, USB speakers, and Peripheral Component 
Interconnect (PCI) expansion cards. To ensure that a device is Plug and Play-compatible, 
see the manufacturer’s documentation that came with the device.

optional device
options bay latch 
(unlocked position)
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To install a Plug and Play device on a computer running Windows 98, perform the 
following steps:

1. Save and exit any application programs and files you have open.

2. Shut down Windows 98.

For instructions, see the section, “Shutting Down Your Computer,” in Chapter 4.

3. Turn off and unplug the computer.

4. Connect the device to the computer according to the manufacturer’s instructions.

5. Plug in and turn on the computer.

When Windows 98 starts, a New Hardware Found window appears to indicate 
that the device has been detected and configured.

NOTE: To install and configure a non-Plug and Play device for use with Windows 98, 
access the Add New Hardware tab by clicking the Start button, pointing to Settings, 
clicking Control Panel, and double-clicking the Add New Hardware icon. Follow the 
instructions displayed to install the non-Plug and Play device.

&'�520�DQG�'9'�520�'ULYHV���
CD-ROM and DVD-ROM drives read audio CDs and a variety of other CD formats. The 
DVD-ROM drive also plays DVDs.

&$87,21� 'R QRW XVH WKH &'�520 GULYH ZKLOH WKH FRPSXWHU LV LQ PRWLRQ�
'RLQJ VR FRXOG LQWHUUXSW WKH IORZ RI GDWD EHWZHHQ WKH &'�520 GULYH DQG
WKH KDUG�GLVN GULYH RU GLVNHWWH GULYH�

To use a disc in the drive, follow these steps:

1. Press the open/close button on the front of the drive to open the disc tray.

&$87,21� 'R QRW SUHVV GRZQ RQ WKH GLVF WUD\ ZKHQ RSHQLQJ RU FORVLQJ LW�

2. Place the disc in the center of the disc tray with the label side facing up. 

3. Center the disc on the spindle, as shown in Figure 5-9. Then gently press the CD 
or DVD down on both sides of the spindle until the disc snaps into place.
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)LJXUH ���� ,QVHUWLQJ D 'LVF LQWR WKH 'ULYH

If the disc is not properly seated, the disc and CD-ROM or DVD-ROM drive will be 
damaged.

4. Close the tray by pressing the open/close button or by lightly pressing the front 
edge of the tray (the tray will automatically close). You can use key combinations 
to control the volume.

NOTE: High-speed CD-ROM or DVD-ROM drives spin the disc at a very high rota-
tional speed and may be noisy. If a disc has printing on only half of the disc, or if 
there is a slight imbalance in the disc, the imbalance is greatly magnified by the 
high speed and the noise is louder. This effect is inherent in the high-speed tech-
nology and does not indicate a problem with the drive.

When the drive is in use, the drive-access indicator blinks on the front of the drive 
bezel.

When using a CD-ROM or DVD-ROM drive, follow these guidelines:

� Disable the autoplay feature while you are using the drive.

� Never use damaged, broken, or deformed discs.

� Do not press the open/close button while the computer is accessing a disc.

� Keep the disc tray closed when not using the drive.

6SHDNHUV�
You can connect speakers, a microphone, headphones, and record/playback devices 
such as cassette players, CD players, and VCRs to the sound jacks on the computer. 
Dell recommends using amplified speakers for the best sound.
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)LJXUH ����� $XGLR -DFNV

Connect headphones or speakers to the line-out jack (see Figure 5-10). Connect a 
microphone to the microphone jack. Connect record/playback devices such as cas-
sette players, CD players, and VCRs to the line-in jack.

See your Windows 98 documentation for the location of sound applications such as 
mixers and volume control.

You can use keyboard commands to control the sound coming from the external 
speakers, as well as the sound from the computer's built-in speakers. Press 
<Fn><Page Down> to lower the volume. Press <Fn><Page Up> to increase the vol-
ume. Press <Fn><End> to enable or disable both the built-in and external speakers.

NOTE: If no sound comes from the speakers, make sure that the sound is not dis-
abled by pressing <Fn><End>.

When you adjust the volume knob on some USB speakers, a window pops up on your 
screen that provides various audio controls. For information on using this interface, 
refer to the documentation that came with the speakers.

3RUW�5HSOLFDWRU�
The I/O connectors on the back of the Dell Inspiron 3500 Port Replicator duplicate those 
on the back of your computer, so you can attach any external device to the replicator 
that you can attach to the computer. In addition to the standard I/O connectors, the rep-
licator has an additional PS/2 connector, audio connectors, and a security cable slot.

For more information, see the Dell Inspiron 3500 Port Replicator User’s Guide. 

&RQQHFWLQJ�WKH�5HSOLFDWRU�WR�WKH�&RPSXWHU

To connect the computer to the replicator, follow these steps:

1. Save all your work, and exit all open application programs.

2. Turn off the computer.

line-in jack line-out jackmicrophone jack
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3. Connect the AC adapter to the replicator, and plug the AC power cable into an 
electrical outlet.

4. Place the computer on the replicator platform, with the back of the computer fac-
ing the replicator's docking connector.

Make sure that the grooves on the bottom of the computer align properly with 
the platform rails.

5. Position your fingers on the platform grips, and use your thumbs to push the 
computer forward until the docking connectors are fully engaged.

'HWDFKLQJ�WKH�&RPSXWHU�)URP�WKH�5HSOLFDWRU

To detach the computer from the replicator, follow these steps:

1. Make sure that there is a charged battery in the computer.

2. Turn off the computer.

3. Pull the release handles on the side of the replicator to undock the computer (see 
Figure 5-11).

)LJXUH ����� 'HWDFKLQJ WKH &RPSXWHU )URP WKH 5HSOLFDWRU

release 
handles (2)
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$GGLQJ�D�3ULQWHU�
&$87,21� 7R PDLQWDLQ D VWURQJ VLJQDO IURP WKH FRPSXWHU� XVH D
ELGLUHFWLRQDO SDUDOOHO FDEOH PHDVXULQJ �� IHHW RU OHVV� /RQJHU FDEOHV PD\
SUHYHQW WKH SULQWHU IURP RSHUDWLQJ SURSHUO\�

Most printers come with specific instructions for connection and installation of neces-
sary software and drivers. If your printer does not, follow these steps:

1. Turn off the computer and any attached devices. Then disconnect them from their 
AC power sources.

2. Connect the printer cables as instructed in the printer documentation. 

3. Reconnect the computer to AC power. Turn on the printer, and then turn on the 
computer.

4. If the printer is not automatically detected during operating system start-up, 
double-click the My Computer icon on your desktop.

5. Double-click the Printers folder.

6. Double-click the Add Printer icon.

7. In the Printer Wizard dialog box, click either the My Computer option or the 
Network Printer Server option and then click Next>.

8. Click the port that you want to use.

Choose the computer port to which you connected the printer. The parallel port 
with the printer icon is LPT1, and is the most commonly used printer port. The 
serial port, marked with “I/O,” is the COM port. Refer to the printer documenta-
tion to determine which port to use.

Verify that the port you chose is not already assigned to another device. If neces-
sary, add a port or configure a port by using the buttons in the Printer Wizard 
dialog box.

9. Select the printer manufacturer and model from the list provided, or click Have 

Disk... if your printer is not listed and the printer drivers are on a diskette.

Refer to the documentation that came with your printer for more information.

10. Provide the printer name (up to 31 characters) and click Next>.

11. Indicate whether the printer will be shared with other network users by clicking 
either the Shared or Not shared option.

If the printer will be shared, the Connect to Printer dialog box appears. Continue 
to step 12.

If the printer will not be shared, go to step 14.
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12. Select your printer from the list provided or type the printer name, and then click 
OK.

13. Select all the operating systems (from the list provided) required to print to the 
shared printer.

14. Click Next> to continue.

15. Select Yes or No to indicate whether you want to print a test page. Then click 
Finish.

6\VWHP�8SJUDGHV
You can purchase various upgrades for your computer, including memory, hard-disk 
drives, printers, scanners, and so on. Refer to the Dell System User’s Guide for infor-
mation on upgrading your computer.
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)UHTXHQWO\�$VNHG�4XHVWLRQV

Many common questions about your Dell computer are answered in this chapter. If 
you do not find a solution, refer to the “Contacting Dell” section of the System User’s 
Guide. For troubleshooting tips and diagnostic tools, refer to the Reference and 
Troubleshooting Guide. 

*HQHUDO�4XHVWLRQV

+RZ�GR�,�DFFHVV�WKH�6\VWHP�8VHU·V�*XLGH�IRU�LQIRUPDWLRQ�
DERXW�P\�FRPSXWHU"

To open the guide, click the Dell System User’s Guide icon on your desktop.

:KHUH�FDQ�,�ILQG�WKH�VSHFLILFDWLRQV�IRU�P\�FRPSXWHU"�)RU�
P\�LQVWDOOHG�GHYLFHV"

Computer specifications are provided in the “Specifications” section of the Dell Sys-
tem User’s Guide and in Appendix A, “Technical Specifications” of the Reference and 
Troubleshooting Guide. Specifications for installed devices can be found in the device 
manufacturer’s documentation that came with your computer.

+RZ�GR�,�FRQQHFW�WR�WKH�,QWHUQHW"

Instructions for accessing the Internet can be found in Chapter 2, “Connecting to the 
Internet.”

6RIWZDUH�4XHVWLRQV�

,
YH�ORVW�WKH�'HOO�&KDQQHO��+RZ�GR�,�JHW�LW�EDFN"

The Dell Channel can be downloaded from the Dell Channel subscription page at 
http://www.dell.com/getie4.
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,V�WKHUH�D�QHZ�%,26�DYDLODEOH�IRU�P\�FRPSXWHU"�6KRXOG�,�
XSGDWH"

Basic input/output system (BIOS) updates are available from Dell’s File Library; they 
are released to either fix problems or add features. You should probably not upgrade 
your BIOS unless it is recommended by a Dell technician or you are experiencing 
problems with your hardware configuration. Always read the release notes included 
with the update thoroughly before making a decision to upgrade your BIOS.

:LOO�P\�FRPSXWHU�FRUUHFWO\�KDQGOH�WKH�<HDU������
SUREOHP"

Your computer is set to automatically correct the date after 1/1/2000 occurs. It will 
then continue to keep and update dates correctly. For more information about Year 
2000 issues, refer to the Research and Development section of the Dell Web site 
(http://www.dell.com).

+DUGZDUH�4XHVWLRQV�

7KH�IRUPDWWHG�FDSDFLW\�RI�P\�KDUG�GLVN�GULYH�VHHPV�WR�
EH�VPDOOHU�WKDQ�ZKDW�,�RUGHUHG��:KHUH�LV�WKH�PLVVLQJ�
VSDFH"�

The Windows 98 operating system reports drive capacity assuming that 1 megabyte 
(MB) equals 1,048,576 bytes. This calculation is technically correct.

Drive manufacturers compute the size differently. They consider 1 MB to equal 
1,000,000 bytes. This difference can cause confusion! If the drive is advertised as 
4.3 gigabytes (GB) (4,300,000,000 bytes), the operating system sees it as approxi-
mately 4.1 GB (4,300,000,000 / 1,048,576 / 1000 = 4.100799560547).

7KHUH�LV�QR�VRXQG�FRPLQJ�IURP�P\�FRPSXWHU��:KDW·V�
ZURQJ"

You can use keyboard commands to control the sound coming from your computer 
speakers. 

If no sound comes from the speakers, make sure that the sound is not disabled by 
pressing <Fn><End>.

0\�GLVSOD\�LV�EODQN��:KDW�VKRXOG�,�GR"

Your computer might be in Standby, which is battery power conservation mode. Press 
the power button to resume operation. 

The Dell System User’s Guide has more information on conserving battery power. 
6-2 Dell Inspiron 3500 Setup Guide



+RZ�GR�,�NQRZ�KRZ�PXFK�EDWWHU\�SRZHU�,�KDYH"

Before starting the computer, remove the battery. There is a charge gauge on the bat-
tery that tells you how much power remains in the battery. To activate the charge 
gauge, press the button next to the battery connector. Lights on the charge gauge 
light up to indicate the amount of charge in the battery. The more lights that light up, 
the more charge the battery has.

)LJXUH ���� %DWWHU\ &KDUJH *DXJH

See the Dell System User’s Guide for more information on the battery. 

You can also double-click on the battery icon in the Windows 98 taskbar for informa-
tion on battery power. If you are using the AC adapter, the battery icon does not 
appear. 

0\�PRQLWRU�LV�IODVKLQJ�GLIIHUHQW�FRORUV�ZKHQ�,�FKDQJH�
VFUHHQV��+RZ�GR�,�IL[�LW"

If your monitor is flashing different colors when you change screens, follow these 
steps:

1. Click the Start button, point to Settings, and then click Control Panel.

2. In the Control Panel, double-click the Display icon. Then click the Settings tab.

3. In the Colors box, select High Color (16 bit) or True Color (32 bit). Then click OK.

4. In the Compatibility Warning window, click the Apply the settings without 

restarting? radio button, and then click OK.

5. When prompted, click OK to adjust the display.

6. When prompted, click Yes to accept the changes. 

charge gauge 

charge gauge button
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:KHUH�FDQ�,�ILQG�GULYHUV�IRU�P\�PRQLWRU"

Monitors do not require drivers; video cards require drivers. If the question is which 
monitor to select, choose either the Dell monitor model you have or the Plug and Play 
monitor (VESA® DDC option). If the question is which video drivers to use, use the 
ones provided with the video card. Newer drivers may also be available from the Dell 
Web site (http://www.dell.com).

Posted on the Dell Web site and the Dell bulletin board service (BBS) is the 
dd78906.exe file. This file self-extracts into dellmon.inf and contains information on 
the latest Dell monitors. To use this file, follow these steps:

1. Download the file onto a diskette, and insert the diskette into the diskette drive 
after the operating system starts.

2. Click the Start button, point to Settings, and then click Control Panel.

3. Double-click the Display icon, and then click the Settings tab.

4. Click Advanced, and then click Monitor.

5. Click Change and then click Have Disk. Specify the location of the 
dellmon.inf file (A:). 

*HWWLQJ�+HOS������
Dell provides a number of tools to help you if you don’t understand a procedure 
described in this guide or if your computer does not perform as expected. For infor-
mation on these help tools, see Chapter 5, “Getting Help,” in the Reference and 
Troubleshooting Guide or the “Contacting Dell” section of the Dell System User’s 
Guide.

Dell has also established a dedicated toll-free telephone number to assist Inspiron 3500 
computer customers in the U.S. and Canada. Dell’s technical support staff can answer 
your questions about features and operation of the Inspiron 3500 computer. This help is 
available 24 hours a day, seven days a week. To contact Inspiron 3500 technical support, 
call 1-877-326-3355. Before you call, locate your Express Service Code on the bottom of 
the computer.

If you need help with hardware or software that was not Dell-installed, contact the 
manufacturer of that item. For DellWare items, call 1-800-753-7201 to receive product 
support information.
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CD-ROM drives, 5-13
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frequently asked questions, 6-2
keyboard, 5-7
mouse, 5-11
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port replicator, 5-15
printer, 5-17
speakers, 5-14
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icons. See shortcuts
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